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[ Features

Your RadioShack USB Flatbed Color
Scanner is designed for notebook or
desktop PCs that have a universal serial
bus (USB) port. You can use the scan-
ner to quickly scan information, such as
documents and photographs, in color or
grayscale. Then you can use the soft-
ware supplied with your scanner to con-
vert the scanned images to electronic
files.

Your scanner’s features include:

USB Operation — lets you easily con-
nect and begin using the scanner.

600 x 1200 DPI (Dots per Inch) Reso-
lution — provides high-resolution scan-
ning.

36-Bit Color Scanning — your scanner
scans over 68 billion colors.

On-Screen Control — you can control
the scanner directly from your comput-
er's screen using the supplied software.

On-Scanner Controls — lets you also
use the scanner’s buttons to control it,
SO you can use the scanner even if it is
located away from your computer.

Wide Scanning Area
most documents.

— lets you scan

Supplied PaperPort U Software — lets
you quickly link images you scan with
more than 150 applications you use ev-
eryday.

Fast Scanning — scans and outputs
images in seconds.

WARNING: To reduce the risk of fire or
shock hazard, do not expose this product to rain
or moisture.

RISK OF ELECTRIC SHOCK.
DO NOT OPEN.

CAUTION: TO REDUCE THE RISK OF
ELECTRIC SHOCK, DO NOT REMOVE
COVER OR BACK. NO USER-SERVICE-
ABLE PARTS INSIDE. REFER SERVICING
TO QUALIFIED PERSONNEL.

This symbol is intended to alert
you to the presence of uninsu-
lated dangerous voltage within
the product’s enclosure that might
be of sufficient magnitude to con-
stitute a risk of electric shock. Do
not open the product’s case.

/N

This symbol is intended to inform
you that important operating and
maintenance instructions are
included in the literature accom-
panying this product.

/N

The graphical symbols with supplemental mark-
ings are located on the bottom of the scanner.
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THE FCC WANTS YOU TO
KNOW

This equipment complies with the limits
for a Class B digital device as specified
in Part 15 of FCC Rules. These limits
provide reasonable protection against
radio and TV interference in a residential
area. However, your equipment might
cause TV or radio interference even
when it is operating properly. To elimi-
nate interference, you can try one or
more of the following corrective mea-
sures:

* reorient or relocate the receiving
antenna

* increase the distance between the
equipment and the radio or TV

 use outlets on different electrical cir-
cuits for the equipment and the
radio or TV

Consult your local RadioShack store if
the problem still exists.

You must use shielded interface cables
with this equipment.

FCC DECLARATION OF
CONFORMITY

This device complies with Part 15 of the
FCC Rules. Operation is subject to the
following two conditions: (1) this device
may not cause harmful interference, and
(2) this device must accept any interfer-
ence received, including interference
that may cause undesired operation.

Product:  USB Flatbed Color
Scanner
Model: FU62ED
Responsible Party:  RadioShack
100 Throckmorton
Fort Worth, TX 76102
Phone:  817-415-3200

C
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SYSTEM REQUIREMENTS

« IBMY PC or compatible with one
available USB port

CD-ROM drive

VGA or SVGA monitor

16MB or more of available internal
memory (RAM)

35MB of free hard disk space
« Microsoft Windows!H 98

Important:  Your scanner will not work
with Windows 95. You must have Win-
dows 98 installed on your computer to
use the scanner.

MONITOR
REQUIREMENTS

To use the scanner with your computer’s
monitor, set the monitor to High Color
(16-bit) or True Color (24- or 32-bit).
Then set your monitor's resolution to at
least 800 x 600 DPI.

To set your monitor's colors and resolu-
tion, open the Windows Control Panel,
double-click Display , then click Settings .

Features



O Important Safety Instructions

1.

Read Instructions — All the safety
and operating instructions should be
read before the scanner is operated.

. Retain Instructions — The safety

and operating instructions should be
retained for future reference.

. Heed Warnings — All warnings on

the scanner and in the operating
instructions should be adhered to.

. Follow Instructions — All operating

and use instructions should be fol-
lowed.

. Water and Moisture — The scanner

should not be used near water (for
example near a bathtub, in a wet
basement, or near a swimming pool,
and so on).

. Carts and Stands — The scanner

should be used only with a cart or
stand that is recommended by the
manufacturer.

. Ventilation — The scanner should

be situated so that its location or
position does not interfere with its
proper functioning. For example, the
scanner should not be situated on a
bed, sofa, rug, or similar surface
that may obstruct the ventilation.

. Heat — The scanner should be situ-

ated away from heat sources such
as radiators, heat registers, stoves,
or other scanners (including amplifi-
ers) that produce heat.

9.

10.

11.

12.

13.

14.

Power Sources — The scanner
should be connected to a power
source only of the type described in
the operating instructions or as
marked on the scanner.

Power Cord Protection — Power
supply cords should be routed so
that they are not likely to be walked
on or pinched by items placed upon
or against them, paying particular
attention to cords at plugs, conve-
nience receptacles, and the point
where the cords exit from the scan-
ner.

Cleaning — The scanner should be
cleaned only as recommended by
the manufacturer. Do not use chem-
ical cleaners.

Non-Use Periods — The power cord
of the scanner should be unplugged
from the outlet when the scanner is
not being used for a long period of
time.

Object and Liquid Entry — Care
should be taken so that objects do
not fall, and liquids are not spilled,
on the scanner.

Damage Requiring Service — The
scanner should be serviced by qual-
ified service personnel when:

A. The power cord or the plug has
been damaged; or

B. Objects have fallen, or liquid has
been spilled into the scanner; or

Important Safety Instructions



15.

C. The scanner has been exposed
to rain; or

D. The scanner does not appear to
operate normally or exhibits a
marked change in performance; or

E. The scanner has been dropped,
or the enclosure has been dam-
aged.

Servicing — The user should not
attempt to service the scanner
beyond that described in the operat-
ing instructions. All other servicing
should be referred to qualified ser-
vice personnel.

Important Safety Instructions



O Preparation

LOCKING/UNLOCKING
THE SCANNER

Your scanner has a locking mechanism
to protect it during shipment or while you
move it.

Before you use the scanner, slide LOCK/
UNLOCK on the bottom of the scanner
toward UNLOCK. To protect the scan-
ner's mechanism when you move or
ship it, slide LOCK/UNLOCK toward
LOCK.

CONNECTING AC POWER
TO THE SCANNER

The scanner uses the supplied 12V,
1250-mA AC adapter for power.

Cautions:
You must use a Class 2
A power source that supplies
12V DC and delivers at
least 1250 mA. Its center tip must be
set to positive and its plug must fit
the scanner's DC 12V jack. The sup-
plied adapter meets these specifica-
tions. Using an adapter that does
not meet these specifications could
damage the scanner or the adapter.

* Always connect the AC adapter to
the scanner before you connect it to
AC power. When you finish, discon-
nect the adapter from AC power be-
fore you disconnect it from the
scanner.

Plug the AC adapter’'s barrel plug into
the DC 12V jack on the back of the scan-
ner, then plug the other end of the AC
adapter into a standard AC outlet. The
indicator on the front of the scanner
lights, indicating that the scanner is
turned on.

Note: The scanning lamp under the
scanner's glass automatically remains lit
so you do not have to warm up the scan-
ner each time you want to scan. To con-
serve electricity and prolong the
scanner's life, the lamp automatically
turns off after a while.

INSTALLING THE
SCANNER'’S SOFTWARE/
HARDWARE

To use your new scanner, you must in-
stall the supplied PaperPort software on
your computer then connect the scanner
to the computer.

The PaperPort software includes instal-
lation files and a User's Guide. This
guide provides more detailed informa-
tion about the PaperPort software's fea-
tures. You can read the guide while the
CD is running, or print a copy directly
from your hard drive to your printer. To
read the guide, click Start, Programs,
then PaperPort .

You do not need to turn off the computer
before connecting or disconnecting your
scanner.
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Follow these steps to install the Paper-
Port software on your computer.

1. Start Windows 98 and quit all appli-
cations.

2. Insert the PaperPort software CD
into your CD-ROM drive. The CD
starts automatically.

Note: If the PaperPort CD does not
start automatically, make sure the
CD-ROM's door is completely shut.
If the CD still does not start, the auto
run option on your computer might
be turned off. If this happens, click
My Computer. The window shows
the available drives on your com-
puter. Then double-click the icon for
your CD-ROM drive and double-
click setup.exe. The CD starts.

3. Follow the instructions that appear.
When you are prompted to do so,
plug one end of the supplied cable
into your computer’s USB port.

Notes:

* The supplied cable fits only one
way. If it does not insert easily, do
not force it.

» Refer to your computer’s owner’s
manual for the location of the
USB port.

» Some new computers also have a
keyboard with a built-in USB port.
You can plug the scanner’s cable
into the keyboard instead of the
computer.

4. Plug the other end of the supplied
cable into the USB port on the back
of the scanner.

5. After you finish installing the soft-
ware, restart your computer.

Note: Once the scanner is working, you
can install the other applications provid-
ed with the CD.

VERIFYING SUCCESSFUL
CONNECTION

After you successfully install the
scanner, the scanner icon ap-
pears at the bottom right corner
of the Windows taskbar. The in-
dicator on top of the scanner turns green
when the scanner and computer com-
municate.

o

If the scanner icon appears with
an X through it instead, the
scanner is not properly connect-
ed. See “Troubleshooting” on
Page 19 for more information.

2

Follow these steps to confirm if the
scanner has been successfully connect-
ed.

1. Right-click the scanner icon on the
Windows taskbar. The shortcut
menu appears.

2. Click About. A dialog box appears,
confirming your scanner’s settings.

3. Click OK to close the dialog box.
Your scanner is ready to scan.

Preparation 9



O Default Button Settings

You can configure the scanner’s buttons to perform different functions. See “Chang-
ing a Scanner Button's Settings” on Page 15). The default settings are:

Button Destination Scan Setting Resolution (DPI)

STOP/ Cancels the scan in progress. None None

CANCEL

CUSTOM | Converts scanned text to word None None
processing text in Windows
Notepad.

FAX Displays the scanned object in Black and white Your fax machine’s
fax application software installed default resolution.

on your computer.

COPY/ Prints the scanned object on Black and white Your printer’s or
PRINT printer or copier. copier’s default res-
olution.
SCAN Displays the scanned objectina | 842 x 11 inch 100
PaperPort window. color photo

Note: If a button is not pre-configured (for example, if your computer does not have
fax software installed so FAX cannot be pre-configured), a dialog box appears to re-
mind you to configure that button manually.

o T BT b T e
| Seanmner T d= 10 Be Coi ]

Before wou can start nsng this button, it needs to
7) be configured

The next dialog allows o fo configure this
button. Refer to wour manval for additiomal
information.
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J Operation

You can operate the scanner using the
buttons on the front of the scanner, from
your computer screen, or using the sup-
plied PaperPort program.

GETTING HELP

The supplied software includes help in-
formation which describes each feature
of the software and answers questions
about how to configure the buttons for
the best scanning result.

To view help, click Help on the USB
Scanner Utility Preferences dialog box
or on the other dialog boxes you use to
select options for the buttons.

USING THE SCANNER’S
BUTTONS

To scan a document
using the buttons on
the front of the scan-
ner, open the scan-
ner's top cover and
place the document
facedown on the
glass. Then close
the cover and press
SCAN.

The scanner starts scanning the docu-
ment, Scan: PaperPort Desktop

appears, and a window displays the
scanning progress.

Note: If you are using the scanner for
the first time or if it has not warmed up
yet, the scanner automatically warms it-
self up for about 45 seconds before

scanning. A confirmation message ap-
pears while the scanner is warming up.

When the scan is complete, the scanned
image is transmitted to the preset desti-
nation or a destination you select (see
“Default Button Settings” on Page 10).

USING THE SCANNER
ICON

Operating the scanner from the screen
is just like pressing a scanner button,
except you click the button on the
screen. This scanning method is espe-
cially helpful if the scanner is not located
close to your computer.

Follow these steps to scan using the
scanner icon on the screen.

1. Open the document cover and place
the object to scan facedown on the
glass. Then close the cover.

2. Click the scanner icon on the Win-
dows taskbar. The USB Scanner
Utility dialog box appears.

3. Click Scan. The scanner starts scan-
ning the object, a message appears
just above the Windows taskbar,
and a window shows the scanning
progress.

4. When the scanner has finished
scanning, it sends the image either
to the printer to print, or to another
program you have loaded on your
computer, depending on the current
software settings.

Operation 11



USING THE SUPPLIED PAPERPORT SOFTWARE

Instead of using the scanner's buttons, you can use the supplied PaperPort software
to control your scanner. This is useful when you are using PaperPort to file and save
your scanned objects.

Note: You can also install and use other scanning software, including many graphics
and imaging applications, with your scanner. The software must meet Twain stan-
dards.

Follow these steps to scan using the supplied PaperPort software.

1.

If the PaperPort software is not currently running, double-click the PaperPort icon
on the Windows desktop to start it. The PaperPort desktop appears. You can use
this window to select and work with scanned images. The links at the bottom of
the desktop let you link images you scan to other software installed on your com-
puter.

Note: If you need more information about the PaperPort desktop, click Help.

. From the File menu, click on Select Source . The Select Source dialog box

appears.
X

Sources:

Cancel

. If necessary, click on USB Scanner. Then click Select.

Note: You only need to follow Steps 1-3 once unless you change the source to
another Twain device such as a digital camera.

. Click the Twain icon on the PaperPort command bar. A window appears, letting

you preview the scanned image. Make any adjustments, then scan the final
image.

. Open the document cover and place the object to scan facedown on the glass.

Then close the cover.

12
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6. Click Preview. The scanner scans
the object and displays a preview
using the options you selected.

7. Review the image to make sure it is
what you want. Readjust the set-
tings if necessary.

8. To see a preview again before scan-
ning the final image, click Preview.

9. When you are satisfied with the
image settings, click Scan.

The scanner starts scanning the
object, and a progress bar appears
showing the percentage completed.

When the scan is complete, the scanned
image appears in the destination soft-
ware.

USING THE TWAIN
BUTTON

Instead of using the scanner's buttons or
PaperPort software, you can use the
supplied Twain software to control your
scanner. This lets you scan many types
of objects, from small business cards to
Ad-sized pages.

Note: Your scanner is initially set to
scan from the PaperPort software with
the setting Color Document —Faster. To
scan a black-and-white image, select
one of the other settings. To scan at a
higher resolution for a color image, se-
lect Color Document —Better Quality .
However, scanning at a higher resolu-
tion creates a larger file size and takes
longer to scan. To minimize the file size
and the time required to get a better
guality scan, select just the area of the
object that you want to scan.

Follow these steps to scan using the
Twain button.

1. Open the document cover and place
the object to scan facedown on the
glass. Then close the cover.

2. If the PaperPort software is not cur-
rently running, double-click the
PaperPort icon on the Windows
desktop to start it. The PaperPort
Desktop appears.

3. Click the Twain icon on the com-
mand bar or click Acquire on the
File menu. The USB Scanner dialog
box appears.

Note: When scanning from other
Twain software, choose Acquire or
Scan from the File menu. Other
Twain software will usually not have
a Twain button.

4. Adjust the desired Twain options.

Scan Page For — Select one of
these preset options if you want to
use it for scanning. These options
are optimized for the various uses of
scanned images, such as scanning
for editing text or scanning in color.
For more information about these
settings, see “Pre-Defining Scan
Settings” on Page 17. If you do not
want to use one of these preset
options, you can manually select the
scan configuration options. Note
that when you select a preset
option, scan configuration settings
are for that preset option. You can
also create your own custom config-
urations. See the Help information
for details.
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Scan Configuration — Use this sec-
tion of the dialog box to manually
select scan options for the image.

Mode — From left to right, the three
modes are color, grayscale, and
black and white. The same symbols
next to the preset options indicate
their mode setting. Click a mode to
select it for the scan.

Res — This is the resolution setting
for the scan in dots-per-inch (DPI).
The higher the DPI, the sharper the
image. But higher DPI settings also
produce larger files sizes. Usually
the higher resolution settings are
used for precision work, such as
photographs or fine artwork. Click
the drop-down arrow and choose
one of the resolution settings from
the list.

Size — The page size for the image.
If you want to use one of those pre-
set sizes, click the drop-down arrow
and choose the size from the list. If
you want to create a custom size,
click on the picture window and drag
the mouse. A dotted box on the win-
dow indicates the page size, and the
two number boxes (with the vertical
and horizontal symbols next to
them) show the actual page size in
inches. You can also enter the verti-
cal and horizontal sizes in those two
number boxes.

AutoCrop — Select this option to let
the scanner automatically determine
the size of the object being
scanned. For example, if you put a
photo in the middle of the glass, the
scanner will automatically determine
the size of the photo. When

AutoCrop is selected, the scanner
makes two passes. The first pass
senses the object's size and the
second pass scans the image.

Note: This option overrides any
selections you make using Size.

Adv. Setting — Click this button to
see advanced settings for scanning.
See the Help information for details
about the advanced settings.

Note: For more details about the
Scan Manager's features, choose
PaperPort Help Topics from the Help
menu.

5. Click Preview. The scanner scans
the object and displays a preview
using the options you selected.

6. Review the image to make sure it is
what you want. Then select the por-
tion of the image you want to scan
or adjust the settings if necessary.

7. To see a preview again before scan-
ning the final image, click Preview .

8. When you are satisfied with the
image settings, click Scan.

The scanner now re-scans the object
and displays the final image as a thumb-
nail on the PaperPort Desktop.

See the PaperPort User's Guide and
Working with PaperPort for more infor-
mation about using the PaperPort soft-
ware.

14
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O Configuring the Scanner

CHANGING A SCANNER
BUTTON'S SETTINGS

You can change the setting of any of the
scanner’s buttons using the USB Scan-
ner Utility Preferences dialog box. This
dialog box displays a list of options and
settings for customizing the scanner.

Follow these steps to change a scanner
button’s settings.

1. Click the scanner icon on the Win-
dows taskbar. The USB Scanner
Utility — Preferences dialog box
appears.

2. Right-click on the name of the scan-
ner button (except STOP/CANCEL)
you want to view the properties for.
A dialog box showing Scanner Set-
tings for and the name of the button
appear.

3. Click Edit to change the button’s set-
tings.

Note: If you need more information
about each button’s settings, click Help.

ADJUSTING SCAN AND
PAGE SETTINGS

If you use a scan configuration that you
define yourself, you can adjust that con-
figuration's scan settings and page set-
tings. For example, if the scanned image
is too dark, you can adjust the bright-
ness of the scan setting.

Note: You can adjust only the settings
for the configurations that you define
yourself. You cannot change the scan
settings or page settings for any of the
pre-defined scanning configurations.

Follow these steps to adjust scan and
page settings.

1. Hold down any button on the scan-
ner. The USB Scanner Utility Prefer-
ences dialog box appears. The
selected tab on the dialog box corre-
sponds to the button you pressed.
You can click the other tabs for the
other buttons.

2. In the Configuration to Use list, click
the configuration you want to adjust.

Note: You cannot edit or change
pre-defined configurations. To make
a change, you must create a new
configuration or copy an existing
one and give it a new name.

3. If you have not defined a configura-
tion yet, click New to create a new
one. You can also select one of the
pre-defined configurations then click
Copy to copy it.

4. Click Edit. A dialog box appears.

5. Enter a name for the new configura-
tion.

6. Adjust the desired scanning options.

Mode — Select Black/White to scan
in black and white. For example, let-
ters and memos are usually

Configuring the Scanner 15



scanned in black and white. Select
Grayscale to scan objects containing
drawings or black-and-white photo-
graphs. The scanning produces an
image in varying shades of gray.
Select Color to scan color photo-
graphs and other color objects.

Resolution — Drag the slider to the
right or left to adjust the dots per
inch (DPI) of the resolution. The
maximum resolution is 600 DPI, the
minimum is 50 DPI. The higher the
DPI setting, the sharper and clearer
the scanned image. However,
higher DPI settings take longer to
scan and produce larger files for the
scanned images.

Brightness and Contrast — Drag the
sliders to the right or left to adjust
the brightness and contrast of the
scanned image.

. Click the Page Settings tab to adjust

the scanning page settings.

. Adjust the desired page settings.

Page Size — Choose one of the
page sizes from the drop-down list.
The outlines on the picture repre-
sent the various page sizes. Clicking
on one of those outlines also selects
it as the page size for the scan. If
you select the Custom option from
the drop-down list, boxes appear in
place of the picture. Enter the hori-
zontal and vertical page dimensions
for your scan in those boxes.

AutoCrop — Select this option to let
the scanner automatically determine
the size of the object being
scanned. For example, if you put a

photo in the middle of the glass, the
scanner will automatically determine
the size of the photo. When
AutoCrop is selected, the scanner
makes two passes — the first pass
senses the object's size, and the
second pass scans the image. This
option overrides the Page Size menu
selection.

DeScreen — Select this option
when scanning a picture from a
newspaper or magazine article, or
another object that contains images
with patterns or dots. Scans of pat-
terns or dots sometimes have a dis-
torted or wavy appearance. The
scanner scans the object to com-
pensate for the patterns and dots,
and produces a clearer image. The
scanning may slow down a bit when
this option is selected. Do not select
this option when scanning photo-
graphs.

Gamma — Drag the slider to
improve how the colors in a
scanned image look on your moni-
tor. Gamma correction allows you to
achieve precise color matching.
Because the computer cannot
always transmit the exact color
information to the hardware, you
may have to make some color
adjustments using the Gamma fea-
ture.

The default Gamma setting works
fine in most cases and normally
does not need to be adjusted.

. Click Close. The USB Scanner dia-

log box reappears. The new config-
uration and its adjusted settings now
apply to the button.

16
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Note: If you click COPY/PRINT or FAX, the dialog box for editing and adjusting the set-
tings will have a Device tab for selecting options for a printer or copier. See the Help
menu for more information.

PRE-DEFINING SCAN SETTINGS

Selecting the proper scan setting before final scanning provides the best results. The
scan setting determines the sharpness of the object and the number of possible
shades of gray or color. Scan settings also affect the speed of the scan and the file
size.

The following table shows the pre-defined scan settings you can use.

Scan Setting Default Setting To Scan Description
Faxing, Filing, | Black and white, Newspaper and maga- Provides the fastest
or Copying 200 DPI zine articles, receipts, scan time and smallest
forms, and other text file size.
objects
Editing Text Black and white, | Business letters, con- Enhances the use of
(OCR) 300 DPI tracts, memos, and other | OCR software for con-
documents you want to verting object text to
edit editable text. Provides
higher quality and larger
file size than the Faxing,
Filing, or Copying scan
setting.
Black-and- Grayscale, 100 Black-and-white photos Provides the best set-
White Photo DPI ting for black-and-white
photos
Color Color, 100 DPI Color pages with many Creates a quality
Photo — graphics, or mixed graph- | scanned color object in
Faster ics and text, line art, or a file that is not too
photos that require a large. PaperPort’'s
quick scan default setting.
Color Color, 200 DPI Photos and color objects | Provides the ideal set-
Photo — ting for color objects,
Better Quality object editing, desktop
publishing, and high-
quality output. Results
in a color scan with
slower scan time and
larger file size.

Configuring the Scanner
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ADJUSTING BRIGHTNESS
AND CONTRAST

The scanner's Advanced Settings let
you adjust a scanned object's brightness
and/or contrast as desired. For example,
you can improve legibility of a black-
and-white document written with a light
pencil by adjusting brightness to be
darker. You can adjust the brightness
and contrast while scanning the object's
grayscale and/or color. If an object is
currently displayed in the preview area,
the changes you make using the Bright-
ness and Contrast control bars are re-
flected in the previewed object.

Follow these steps to adjust brightness
and contrast.

1. Start the PaperPort software.

2. Click the Twain icon on the com-
mand bar or click Acquire on the File
menu. The USB Scanner dialog box
appears.

3. Click Adv. Setting on the USB Scan-
ner dialog box. The Advanced Set-
tings dialog box appears.

4. Click User defined to change the set-
tings.

5. Drag the Brightness slider to the left
to make the scanned object darker,
or to the right to make the scanned
object lighter. When you release the
mouse button, the change s
reflected in the preview object.

6. Drag the Contrast slider to the left to
decrease the contrast or to the right
to increase the contrast for the
scanned object.

Note: See the Help menu for more
details about the Advanced Settings
dialog box.
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J Troubleshooting

If your scanner is not working as it should, these suggestions might help you elimi-
nate the problem. If the scanner still does not operate properly, take it to your local
RadioShack store for assistance.

Problem

Possible Cause

Remedy

B3 appears in
the Windows task-
bar.

The scanner’s cable is
not securely connected
or was disconnected
then reconnected.

Make sure the scanner’s cable is securely
connected. Then right-click the scanner
icon on the Windows taskbar and select
Connect .

The AC adapter is not
connected or is con-
nected incorrectly.

Make sure the AC adapter is securely
connected.

The computer was not
restarted after installing
the PaperPort software.

Restart your computer.

Note: The readme file in the PaperPort di-
rectory included with the supplied soft-
ware provides additional information that
might help you diagnose problems con-
necting the scanner.

The scanner might be
locked.

Unlock the scanner (see “Locking/Unlock-
ing the Scanner” on Page 8).

Scanned images
you work with
using some of the
PaperPort desk-
top’s links look
grainy or too light.

Some of the links default
to 96 DPI, which might
be too grainy or light for

some linked applications.

Select the Link Preferences window from
the Edit menu in the PaperPort Desktop,
then uncheck Convert Images to Screen
Resolution (96 DPI) to disable it.

Power indicator
does not light.

The AC adapter is not
connected or is con-
nected incorrectly.

Make sure the AC adapter is securely
connected.
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[ Care and Maintenance

Your RadioShack USB Flatbed Color Scanner is an example of superior design
and craftsmanship. The following suggestions will help you care for your scanner
S0 you can enjoy it for years.

Sy

Keep the scanner dry. If it gets wet, wipe it dry immediately. Liquids
might contain minerals that can corrode the electronic circuits.

Use and store the scanner only in normal temperature environments.
Temperature extremes can shorten the life of electronic devices and
distort or melt plastic parts.

Keep the scanner away from dust and dirt, which can cause premature
wear of parts.

Handle the scanner gently and carefully. Dropping it can damage circuit
boards and cases and can cause the scanner to work improperly.

Wipe the scanner with a damp cloth occasionally to keep it looking new.
Do not use harsh chemicals, cleaning solvents, or strong detergents to
clean the scanner.

Modifying or tampering with the scanner’s internal components can cause a mal-
function and might invalidate its warranty. If your scanner is not performing as it
should, take it to your local RadioShack store for assistance.

20
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O Specifications

Bit DEPLN .o 36-Bit Color (24-bit output)
12-Bit GrAYSCAIE ..eveviiiiiiiiiii ettt e e ee e e e et e e e e e bt e e e e e atar e e e e s e 1-Bit Line Art
Scanning ResOIULION ........c..eeeeiiiiiiiiee e Optical Resolution: 600 x 1200 DPI
Maximum Resolution (interpolated) ..........cccccveeeiiiiiiiie e 2400 x 2400 DPI
Maximum Scanning Size .........cccceeeiviiiieneeeiinns 8.5 x 11.60 Inches (21.6 x 29.7 cm) (A4 letter)
OPEratiNng SYSLEIMS ...ciiiiiiiiiiee ettt et e e e e et e e e e e s e b e e e e e s s aabbeeaaesannbeeaaeaann Windows 98
Operating Temperature (without condensation) ............cccccoecveveeeennnns 41° to 104°F (5° to 40°C)
Relative Humidity ..........cccocveeeeiiiiieneesiine, 20% to 80% at 95°F (35°C) without condensation
INPUL VORAGE ...ttt ee e et e e e e eneee 120V AC, 60 Hz
(O 1011 o101 o] 17 To = TSRS PRT 12V DC, 15 Watt Max.
Safety and Agency Certifications ...........cccceeeeeirinnnnn. UL, GS, FCC Class B, VCCI Class 2, CE
Dimensions (HWD) .......ccccoveveveeeeeeeeeenna. 38/s x 117/16 X 17%/16 Inches (8.5 x 29.0 X 44.0 cm)

.................................................................................................................. 6.4 1b (2.9 kg)
USB Cable, AC Adapter, Software CD

Specifications are typical; individual units might vary. Specifications are subject to change and
improvement without notice.
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Limited Ninety-Day Warranty

This product is warranted by RadioShack against manufacturing defects in material and workman-
ship under normal use for ninety (90) days from the date of purchase from RadioShack company-
owned stores and authorized RadioShack franchisees and dealers. EXCEPT AS PROVIDED
HEREIN, RadioShack MAKES NO EXPRESS WARRANTIES AND ANY IMPLIED WARRANTIES,
INCLUDING THOSE OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
ARE LIMITED IN DURATION TO THE DURATION OF THE WRITTEN LIMITED WARRANTIES
CONTAINED HEREIN. EXCEPT AS PROVIDED HEREIN, RadioShack SHALL HAVE NO LIABIL-
ITY OR RESPONSIBILITY TO CUSTOMER OR ANY OTHER PERSON OR ENTITY WITH RE-
SPECT TO ANY LIABILITY, LOSS OR DAMAGE CAUSED DIRECTLY OR INDIRECTLY BY USE
OR PERFORMANCE OF THE PRODUCT OR ARISING OUT OF ANY BREACH OF THIS WAR-
RANTY, INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES RESULTING FROM INCONVE-
NIENCE, LOSS OF TIME, DATA, PROPERTY, REVENUE, OR PROFIT OR ANY INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, EVEN IF RadioShack HAS BEEN AD-
VISED OF THE POSSIBILITY OF SUCH DAMAGES.
Some states do not allow limitations on how long an implied warranty lasts or the exclusion or limita-
tion of incidental or consequential damages, so the above limitations or exclusions may not apply to
you.
In the event of a product defect during the warranty period, take the product and the RadioShack
sales receipt as proof of purchase date to any RadioShack store. RadioShack will, at its option, un-
less otherwise provided by law: (a) correct the defect by product repair without charge for parts and
labor; (b) replace the product with one of the same or similar design; or (c) refund the purchase
price. All replaced parts and products, and products on which a refund is made, become the prop-
erty of RadioShack. New or reconditioned parts and products may be used in the performance of
warranty service. Repaired or replaced parts and products are warranted for the remainder of the
original warranty period. You will be charged for repair or replacement of the product made after the
expiration of the warranty period.
This warranty does not cover: (a) damage or failure caused by or attributable to acts of God, abuse,
accident, misuse, improper or abnormal usage, failure to follow instructions, improper installation or
maintenance, alteration, lightning or other incidence of excess voltage or current; (b) any repairs
other than those provided by a RadioShack Authorized Service Facility; (c) consumables such as
fuses or batteries; (d) cosmetic damage; (e) transportation, shipping or insurance costs; or (f) costs
of product removal, installation, set-up service adjustment or reinstallation.
This warranty gives you specific legal rights, and you may also have other rights which vary from
state to state.

RadioShack Customer Relations, 200 Taylor Street, 6th Floor, Fort Worth, TX 76102
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